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Notice and Disclaimer AR

This manual’s sole purpose is to assist installers and/or users in the safe and
efficient installation and usage of the system and/or product, and/or software
described herein.

BEFORE ATTEMPTING TO INSTALL AND/OR USE THE SYSTEM, THE INSTALLER AND
THE USER MUST READ THIS MANUAL AND BECOME FAMILIAR WITH ALL SAFETY
REQUIREMENTS AND OPERATING PROCEDURES.

The system must not be used for purposes other than those for which it
was designed.

The use of the software associated with the system and/or product, if
applicable, is subject to the terms of the license provided as part of the
purchase documents.

ROSSLARE ENTERPRISES LIMITED and/or its related companies and/or
subsidiaries’ (hereafter:"ROSSLARE") exclusive warranty and liability is
limited to the warranty and liability statement provided in an appendix at
the end of this document.

This manual describes the maximum configuration of the system with the
maximum number of functions, including future options. Therefore, not
all functions described in this manual may be available in the specific
system and/or product configuration you purchased.

Incorrect operation or installation, or failure of the user to effectively
maintain the system, relieves the manufacturer (and seller) from all or any
responsibility for consequent noncompliance, damage, or injury.

The text, images and graphics contained in the manual are for the
purpose of illustration and reference only.

In no event shall manufacturer be liable for any special, direct, indirect,
incidental, consequential, exemplary or punitive damages (including,
without limitation, any and all damages from business interruption, loss of
profits or revenue, cost of capital or loss of use of any property or capital
or injury).

All graphics in this manual are for reference only, some deviation between
the image(s) and the actual product may occur.

All wiring diagrams are intended for reference only, the photograph or
graphic of the PCB(s) are intended for clearer illustration and
understanding of the product and may differ from the actual PCB(s).
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Introduction

Rosslare's CP-R25 is a desktop Mifare® and fingerprint card programmer for
Mifare® 1K and 4K RFID proximity cards and tags.

The CP-R25 makes managing fingerprint and Mifare® cards easier and can help
facilitate the effective deployment and control of any facility code application,
including access control, intrusion, and time and attendance applications.

1.1 The CP-R25 System

The CP-R25 is built for high-security, portability and ease of use, enabling high
quality Mifare® and fingerprint enrollment at a low cost.

The CP-R25 programmer is controlled by computer using Rosslare's powerful
AS-BO1 Programmer software package.

1.2 Desktop Convenience

The CP-R25 is small and lightweight, with a slim and attractive design. It is
built for convenience and portability, with a USB 2.0 computer interface, which
makes it quick to install and allows it to run without any additional power
source.

Figure 1: The CP-R25

Designed to sit safely on any desktop, the CP-R25 is sturdily built, with large
card and fingerprint trays and surface-gripping rubber feet.

1.3 Intuitive Software System
The AS-BO1 is a software application intended for programming Mifare® cards,
tags and fingerprints using Rosslare's CP-R25 Desktop Programmer.

The system includes a security authentication system and a real-time
operations log.

Using this tool requires basic understanding of Mifare® cards memory
architecture and access condition mechanisms.

8 CP-R25 Hardware and AS-BO1 Software Manual



Introduction AR

The software does not support all Mifare® cards features required by the
systems using the CP-R25 programmed Mifare® cards.

1.4 Compatibility
The CP-R25 Desktop Programmer and AS-BO1 software are compatible with
other products, including but not limited to:

AY-W6260 and AY-W6360 Read-Sector, Smartcard, Read-Write Access
Control reader family

AY-Q6260 and AY-Q6360 Anti-vandal, read-sector, Smartcard, Read-
Write Access Control reader family

AY-Bx663 (X=1,3,4) Mifare® Smartcard Fingerprint Swipe Sensor family
1.5 Main Features

The CP-R25 Desktop Programmer is a feature-rich Mifare® card programmer
and fingerprint enroller.

1.6 CP-R25 Desktop Programmer

Enables the user to read, verify, and program Mifare® proximity cards
Uses a swipe type fingerprint sensor
Supports USB 2.0 computer connections

Utilizes LED and buzzer sub-systems to indicate programming, card, and
power supply status

Runs a thorough internal diagnostic self-test every time it is powered up
1.7 AS-B01 Software

Programs fingerprints on User cards

Programs ID data on User cards

Produces configuration cards for Rosslare Mifare® readers
Performs firmware updates on supported desktop programmers
Maintains a user log to provide feedback to the software user
Provides password protection

Indicates valid connections with Desktop Programmer

CP-R25 Hardware and AS-BO1 Software Manual 9



Specifications and Requirements

2.1 CP-R25 Hardware Specifications

Data Specifications

Cards
RF Frequency
Bit rate

Mifare® Classic 1K and 4K
13.56 MHz
106 kHz

Fingerprint Reader Specifications

Sensor type Swipe type UPEK TCS4C-TCD50A

Sensor ESD Rating Sensor technology — Capacitive sensor

Electrostatic Discharge: Up to +/- 15 kV air discharge on the sensor surface
FAR - False Accept Rate Actual values depend on specific user's finger, usage

condition and quality of enrollment.
Specification — 0.0010% (1/100000)

FRR - False Reject Rate Actual values depend on specific user's finger, usage
condition and quality of enrollment.

Specification — 2% (1/50)

Electrical Specifications
Operating Voltage 5VDC Via USB

Input Current 75 mA (standby)
160 mA (maximum)

CP-R25 Physical Specifications

Dimensions 17.3x5.8x3.3cm
(Lx W x H) 6.18 x 2.28 x 1.30 inch
Weight 309 g(10.89 0z.)

Environmental Data

Operating Temperature 10°C to 50°C
(50°F to 122°F)
Operating Humidity 5% t0 93% (non-condensing)

10 CP-R25 Hardware and AS-BO1 Software Manual



Specifications and Requirements SetuRTT PROBLCTS

2.2 AS-B01 Software Requirements

Minimum Software Requirements

Operating System Windows XP SP2

Framework Microsoft .NET 2

Processor 400 MHz Pentium or equivalent
RAM Memory 512 Mbytes

Free HD space: 1 Gigabyte

Connection Port USB

CP-R25 Hardware and AS-BO1 Software Manual 11



Installation

3.1 Unpacking the Equipment
The CP-R25 programmer is ready to use immediately “out of the box" and
includes a USB cable and documentation.

Please confirm all the items listed below are received before beginning. If any
items are missing, contact your dealer immediately.

One CP-R25 Programmer

One Male A to Male B USB Cable
One Software CD

Instruction Manual

3.2 CP-R25 Description

The following figure illustrates the CP-R25 components:
Figure 2: CP-R25 Components

Fingerprint Scanner

Fingerprint
Directional Indication

Swip Card
Reader LEDs

Buzzer

Fingerprint Reader
LEDs

uUsB
Connection

3.3 AS-B01 Software Installation

The AS-B0O1 software is included on the installation CD-ROM, which is
packaged with the CP-R25 hardware.

12 CP-R25 Hardware and AS-BO1 Software Manual



Installation e

7o install the AS-B01 software for the first time.
1. Insert the CD into the computer's CD drive.

2. If the Autoloader does not initiate the installation, open My Computer,
double-click on the CD drive icon and then double-click the AS-BO1 setup
file.

y  If Microsoft .NET 2 Framework is not installed on the computer, it is installed
bI automatically before beginning the AS-BO1 installation.

Note

The installation package extracts the installation files. After the files are
extracted, the Welcome to the CP-R25 Setup Wizard screen opens.

Figure 3: AS-B01 Setup - Welcome Screen

i AS-BO1 Setllp

Welcome to the AS-B01 SetUp Setup Wizard

The installer will guide you through the steps required to install A5-B01 SetUp on wour computer.

WARNIMG: This computer program is protected by copyright law and international treaties.
Unautharized duplication or distribution of this program, or any portion of it, may result in severe civil
ar criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Cancel

3. Click Next.
The Select Installation Folder screen opens.

CP-R25 Hardware and AS-BO1 Software Manual 13



Installation

14

Fi

iz AS-BO1

Select

Folder:

The inztaller will install AS5-B01 SetUp to the following folder.

Ta inztall in this folder, click "Mest". To install to a different folder, enter it below or click “Browse".

gure 4: AS-B01 Setup - Select Installation Folder

Setlp

Installation Folder

C:\Program Files\Rosslareha5-B01T Browse...

Install 45-B01 Setlp for pourself, or for anpone who uzes this computer:

() Everyone
(&) Just me
[ Cancel ] [ < Back ] [ Mext > l
[Optional]Click Disk Cost.... to ensure the computer has sufficient space.
The AS-BOT Setup Disk Space window opens.
Figure 5: ASB01 Setup - Disk Space Availability
i AS-BO1 SetUp Disk Space 3
The list below includes the drives pou can install AS-BOT Setlp ta, along with each drive's
available and required disk space.
Volume Dizk Size Lvailable Fiequire
=] 111GE TIGE 2064
=1 100GE B0GE K
2p 100GE 50GE K
=] 100G S0GE K
Su: 100GE SOGE 14
< | >

Select the users allowed to use the program, Everyone or Just me.

For security
[Optional] Y

purposes it is suggested that Just me is selected.
ou can change the destination folder of the installation:

a. Click Browse.

The sta

ndard Windows Explorer window opens.

b. Navigate to and select the required folder.
Click Next to continue the installation process.
The Confirm Installation screen opens.

CP-R25 Hardware and AS-BO1 Software Manual
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8. Click Next.

The installation process is initiated. When the process finishes, the
Installation Complete screen opens.

9. C(lick Close to complete the installation process.
34 Connecting the CP-R25

The CP-R25 unit does not require special installation. Follow the following
steps to prepare the unit for enroliment.

Before connecting the CP-R25 hardware, ensure that the ASBO1 software is
b, installed and running.

Note

7o connect the CP-R25:

1. Click the AS-BO1 icon on the desktop or select the program from the
Rosslare folder in the Start menu. The login dialog opens.

Figure 6: AS-B01 Login Dialog

AS-B01 version 1.11.39.16 E

Passward

2. Enter a password.

When using the application for the first time, use the default password of
"admin".

After initial use, make sure to change the default password to your
b, company'’s approved password (see Section 7.1).

Note

The AS-B01 software Main Window opens.

CP-R25 Hardware and AS-BO1 Software Manual 15



Installation

Figure 7: AS-B01 - Main Window

%7 AS-BO1 version 1.11.39.16

Fle  Options  Help

Sectar Reader | CPR-25 | CPR-25

General Reader Configuration

Operation Mode Card Type
@ Sector (3 Mitare 1K
© Card Serial Number (CSN) O Mitare 4K
Transmit Format
‘wiegand 26 bits =
D Location
Sectar Number Block Number Byte Number
Operations
Opsration Type Key Select sectors to
@ Pragram card | Program User Card ID + Kepd, v \ New Keyé, [ HEX bytes change key &
O Card utitiss User Card ID (1 to 16777215] () Al sectors
|1 T ‘ Canfirm new Keyd,
() Relevant sectars
[ User Facilty Code
Curtsrt Keys (6 HEX bytes)
T I

Time Description

@ Disconnected

16

At the bottom left of the main window, the connection indication is red
with the description “Disconnected”.

Connect the Desktop Programmer to a PC using the USB cable — one
cable end connects to the PC USB host port output and the other end
connects to the USB connector on the Desktop Programmer.

Windows® automatically installs the required drivers. The Desktop
Programmer receives its power through the USB; no external power
supply is required.

On the AS-BO1 main window, the connection indicator at the bottom of
the window changes from red to green with the description
“Connected” to indicate that the CP-R25 Desktop Programmer is
connected. In addition, the CPR-26 tab that was previously visible closes,
leaving only the CPR-25 tab visible.

CP-R25 Hardware and AS-BO1 Software Manual
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Figure 8: AS-B01 Connectivity — Connected

¥~ AS-BO1 version 1.11.39.16

File  Options  Help

Sectar Reader | CPR-25
P e

Gieneral Reader Configuration

Operation Mods Card Type
@ Sectar @ Mifarz 1K
O Card Serial Number [CSN] O Mitare 4K
Trarsmit Formst
‘wiegand 26 bits ~
1D Location
Sector Number Elock Mumber Byte Mumber
L
Operaticns
Operation Type Keph Select sectors to
@® Program card Program User Cad D + Kepé “] Mewkey (5 HEX bytes) change key &
©) Card utiities User Card ID [1 to 16777215) &) Al sectors
[ 3| Confim new Keys

( Relewant sectors

[ User Facilty Code

=g B

Current Keyé (6 HEX bytes]

11/23/2011 03,5116 Fimuware Version CPR-25 1.5.0.0 detected

11/23/2011 03:51:10 MiFare Programming Reader Connected
11/23/2011 03.3218 MiFare Frogriamming Reader Disconnected

Time: Description
114 N1 09:51:16

T
.Connected |

The event log displays a connected message.

If the indicator does not turn green, and the description still indicates
Disconnected after the USB cable is connected, try disconnecting the USB
cable from the Desktop Programmer and reconnecting it.

When the hardware and software are disconnected, the software can only
function in demonstration mode.

Once the indicator is green and the description is Connected, the CP-R25
Desktop Programmer is ready for use.

CP-R25 Hardware and AS-BO1 Software Manual
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AS-B01 Software Overview and LEDs

4. AS-BO1 Software Overview and
LEDs

This section describes the AS-BO1 and CP-R25 LEDs.
4.1 Software Overview

Once the login is completed with the correct password, the main software
window opens.

Figure 9: AS-B01 - Main Window Layout

¥ AS-BO1 version 1.11.39.16
Fie Options  Hep <————— File Menu

Sector Reader | CPA-25)

Gieneral Reader Configuration

Operation Mods Card Type
@ Sector @ Mifars 1K
O Card Serial Number (C5N) O Mifare 4K
Configuration Tab
Transmit Format Ared
“wiegand 26 bits v
D Location
Sector Number Black Number Byte Nurber
L
Operations
Operation Type Kepd Select sectors to
@ Program card Frogram User Card ID + Kepd, > | Hew Kepa 6 HEX hytss) change key &
(O Card utiities User Card ID (1 to 16777215) (3 Al ssctors

[ = Confim new Keya

O Relewant sectors

User Facity Corl
2] Ut Curent Key (E HEX bytes)

(LI
Time Description
11425/2011 035116 Firmware Version CPR-251.5.0.0 detected
11/29/2011 03.51:10 MiFare Programming Reader Connected Message Log
11/29/2011 09.32:18 MiFare Programming Reader Disconnected Area

(D) connected Connection Status

The AS-BO1 main window consists of the following functional areas:

= File menu area — Used for general operations such as setting global
options on the Desktop Programmer, getting version information, and
closing the software.

= Configuration Tab area — The main working area, which is used for
entering and displaying all card and swipe configuration parameters.

18 CP-R25 Hardware and AS-BO1 Software Manual



AS-B01 Software Overview and LEDs A

Descriptions for fields requiring parameters under all the tabs are described in
Appendix A.

There are two programming tabs:

Sector reader — Used to configure and read sector reader cards. This
tab allows configuring both User ID/Card Serial number user cards as
well as Reader Configuration cards.

Swipe reader — Used to write and read cards containing fingerprint
templates. This tab also allows creating configuration cards for
fingerprint readers.
Message log area — The event log records all activities and provides the
user with real time system monitoring. The information messages may
either be operation success or failure messages, or instruction messages
such as during fingerprint enrollment.

Status information area — Indicates connection status with the CP-R25
Desktop Programmer hardware.

4.2 Indication LEDs

The following table describes LED behavior on the CP-R25 Programmer (see
Figure 2).

Table 1: Indication LEDs

Event Swipe Card Reader  Fingerprint Buzzer Fingerprint
LED Reader LED Directional
Indication LED

General

Power on  One red LED lights for several seconds followed by all the LEDs flashing and
the buzzer beeps 3 times for the duration of 3 seconds.

Card Programming

Card not  Green flashing All off Off All on

loaded

Card On card detection, All off On card Allon

loaded green turns on for 1 detection short
second, then off beep, then off

Write card  Green on for 3 sec All off 3 High tone All on

success beeps

Write card Red on for 3 seconds All off Long buzz All on

fail

CP-R25 Hardware and AS-BO1 Software Manual 19



AS-B01 Software Overview and LEDs

Event Swipe Card Reader  Fingerprint Buzzer Fingerprint
LED Reader LED Directional
Indication LED

Fingerprint Scanning

Waiting  Off Green flashes  Off Rolling LEDs in

for circular mode to

fingerprint indicate finger
swipe

Read Off Green on for 3 3 high-tone Rolling LEDs in

fingerprint sec beeps circular mode to

success indicate finger
swipe

Read Off Red on for 3 Long buzz Turning all LEDs

fingerprint sec on, and then

fail according to

status, leaving all
on or going back
to circular mode

Read finger timeout — When no finger is passed over the scanner for 30
seconds, the CP-R25 Desktop Programmer goes back to Standby mode of
swipe LEDs.

20 CP-R25 Hardware and AS-BO1 Software Manual



Programming Cards and Tags secuRTY PRODLETS

To configure the Mifare® cards and tags, the Configuration Tab area of the
Main Window is used.

Within the Configuration Tab Area, there are three sub-areas whose display
changes depending on what options are selected.

Refer to Appendix B for a description of the various fields that appear in the
Configuration Tab area.

Two of the sub-areas always appear:

General Reader Configuration area — This area is the same for all
configuration functions

Operations area — This area varies according to the configuration function
being performed. The configuration function is selected in the Operation
Type dropdown menu.

The following 2 sub-areas appear depending on what options are selected in
Operation Mode and Qperation Type.

Reader Specific Configurations area — This area is visible when the Sector
Reader tab is active and Program Configuration Card is selected in
Operation Type.

Finger options — This area is visible when the CPR-25 tab is active and
Operation Typeis Program User Card KeyA + template.

The following figure illustrates one of the possible appearances of the
Configuration Tab area.

CP-R25 Hardware and AS-BO1 Software Manual 21



Programming Cards and Tags

Figure 10: AS-B01 Sector Reader Configuration Tab Areas

& AS-BO1 version 1.11.39.16

File  ©Options  Help

Sector Reader | CPR25

Operation Mode:

@ Sector

Transmit Format

Sector Mumber

General Reader Configuration

(O Card Serial Nurber [CSM]

Wwisgand 26 bits ¥ | Configuration Area
ID Location

Reader Specific Configurations

Card Type: LED Control Biuzzer Control
@ Mifare 1 K [] Enable LED [ Enable Buzzer
O Mifare 4 K O] Kepad

General Reader

Block Number Bute Mumber

Reader Specific
Configurations Area

Operations
Operation Type Kepd
& Program card Program Configuration Card Reader Keyb, [B HEX bytes]
O Card utiities
Confirm Reader Keyé
Operations
Area
Description A

11/29/2011 10:00:32
11/29/2011 10:00:26

Firmware Yersion CPR-251.5.0.0 detected

MiF are Programming Reader Connected

(D) Connected

When programming a Mifare® card or tag, the card or tag is placed on the CP-
R25 Desktop Programmer antenna area. The following figure illustrates where
these areas are located on the CP-R25 Desktop Programmer.

Figure 11: CP-R25 Antenna Areas

Tag Antenna
Area

MIFARE Card
Antenna Area
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Programming Cards and Tags secuRTY PRODLETS

The CP-R25 Programmer configures three card or tags types:

Configuration Card — This card is used to configure a reader. The
Configuration card is simply held up against a reader to automatically
program the reader with the relevant security information thus allowing
the reader to identify the user cards or tags.

Master Card — This card is used to put the reader into Configuration mode
so that a Configuration card can then be used to program the reader.

User Card — This card is used to enable access by presenting the card or
tag to the reader. With readers requiring fingerprint identification the
same card or tag is used in conjunction with swiping of the fingertip.

5.1 Programming a Master Card

The Master card is used to put the reader into Configuration mode in which a
Configuration card is then used to program the reader.

To prepare a Master card.

1. Select either the Sector Reader or CP-R25 tab.

2. In the Operations area, in Operation Type, select Create Master Card.

The Operation Mode field is not relevant for configuring Master card. The
default value of Sector can be used.

3. In Card Type, select either Mifare® 1 K or Mifare® 4 K.

From the 7ransmit Format dropdown menu, select the applicable
transmission format.

5. Place either a blank Mifare® card or a Mifare® card that has been
previously used as a Master card on the CP-R25 Desktop Programmer
antenna area.

6. Click Start to begin programming the Mifare® card.

On completion, a message is displayed in the Message Log area to verify
that the programming succeeded.

If the programming is a failure there is a short buzz and the Swipe Card
Reader LEDs light red for three seconds.

5.2 Programming a Configuration Card

A Configuration card is used for configuring specific Rosslare Mifare® and
Fingerprint reader's operation modes. Holding the Configuration card in front
of the reader after presenting the Master card configures that reader. The
organization's Configuration card should be kept in a safe place to avoid being
copied by unauthorized persons as it stores the organization/site KeyA. It is
advisable to create a backup Configuration card and store it in a safe place.

Preparing a sector reader Configuration card requires a KeyA value. Do not
expose the KeyA value to any unauthorized personnel while preparing the
Configuration card.
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Refer to the specific reader’s installation manual for a detailed explanation of
the various options.

5.2.1 Sector Reader Configuration Cards

A Sector Reader Configuration card allows you to create a configuration card,
which is used to configure the various sector readers such as the AY-W6260,
AY-W6360, AY-Q6260, and AY-Q6360 units.

To prepare a Sector Reader Configuration card.
1. Select the Sector Reader tab.

2. Select the applicable Operation Mode, either Sector or Card Serial
Number (CSN).

3. From the Operation Type dropdown menu, select Program
Configuration Card.

In Card Type, select either Mifare® 1 K or Mifare® 4 K.

5. From the Transmit Format dropdown menu, select the applicable
transmission format.

6. For Sector operation mode, select values for the Sector Number, Block
Number, and Byte Number fields in /D Location.

7. Ensure that Operations is set to Program Card.

Define the Led and Buzzer Control behavior by selecting or clearing the
Enable Led and Enable Buzzer checkboxes.

9. For readers with a keypad:
a. Select the Keypad checkbox.
Additional keypad options appear.

b. Inthe Backlight options dropdown menu, select the backlight
behavior.

c. From the Transmit Format dropdown menu, set the keypads’
transmission format.

10. For Sector mode, enter the KeyA to be used by the reader as the unique
KeyA for the organization or site in both the Reader KeyA and the
Confirm Reader KeyA fields.

The KeyA number is hidden by "*" characters, so write down the new key
and keep it in a safe place to avoid exposing this secret key to unauthorized
personnel. The KeyA value is entered as a 12 hexadecimal digit. The default
KeyA is FFFFFFFFFFFF.

11. Place a blank Mifare® card or a card previously configured as a
Configuration card on the CP-R25 Desktop Programmer antenna area.

12. Click Start to begin programming the Mifare® card.

On completion, a message appears in the Message Log area to verify that
the programming succeeded.
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If the programming fails, there is a short buzz and the Swipe Card Reader
LEDs light red for three seconds.

5.2.2  Fingerprint Swipe Reader Configuration Cards

The Fingerprint Swipe Reader Configuration card allows you to create a
Configuration card to configure the various Fingerprint Swipe readers such as
the AY-B1663, AY-B3663, and AY-B4663.

To prepare a Biometric Swipe Configuration Card:

1. Select the CPR-25 tab.

2. In Operation Mode, select either Sector or Card Serial Number (CSN).
3. In Card Type, select either Mifare® 1 K or Mifare® 4 K.
4

From the Transmit Format dropdown menu, select the applicable
transmission format.

5. For Sector operation mode, define the /D Location using the Sector
Number, Block Number, and Byte Number fields.

6. From the Operation Type dropdown menu, select Program
Configuration Card.

7. Ensure that the Operations is set to Program Card.

8. Define the Led and Buzzer Controlbehavior by selecting or clearing the
Enable Led and Enable Buzzer checkboxes.

9. To enable the Lockout feature:
a. Select the Enable checkbox.

b. Define the lockout behavior using the Attempts and Duration
fields.

10. For reports on operational failures, select the Enable checkbox under
Failed operation reporting.

11. In KeyA, enter the KeyA to be used by the reader as the unique KeyA for
the organization or site in both the Reader KeyA and the Confirm
Reader KeyA fields.

The KeyA number is hidden by "*" characters, so write down the new key
and keep it in a safe place to avoid exposing this secret key to unauthorized
personnel. The KeyA value is entered as a 12 hexadecimal digit. The default
KeyA is FFFFFFFFFFFF.

12. Place a blank Mifare® card or a card previously configured as a
Configuration Card on the CP-R25 Desktop Programmer antenna area.

13. Click Start to begin programming the Mifare® card.

On completion, a message appears in the Message Log area to verify that
the programming succeeded.

If the programming fails, there is a short buzz and the swipe Card Reader
LEDs light red for three seconds.

CP-R25 Hardware and AS-BO1 Software Manual 25



Programming Cards and Tags

5.3 Programming User Cards or Tags

In this section, both cards and tags are referred to as cards. The card
configuration type depends on what level of system security is implemented.
The cards configuration depends on the reader type used. There are two
reader types that determine what tab to use when configuring the cards:
Sector reader — Used to configure and read sector reader cards. This tab
allows configuring both User ID/card serial number user cards as well as
reader configuration cards.
Swipe reader — Used to write and read cards containing fingerprint
templates. The CP-R25tab also allows creating configuration cards for
fingerprint readers.
The AS-BO1 application offers various configuration options including the
following:
For a new Mifare® User Card, configuring the Card ID, card key and
fingerprint enroliment separately.
For a previously configured Mifare® User Card, configuring the Card ID
and card key at the same time.
For a previously configured Mifare® User Card, configuring the Card ID,
card key, and fingerprint enrollment at the same time.
Once a card is configured, the Card ID and the KeyA value can be modified, or
if required, completely wiped from the card.

5.3.1 Programming a Sector Reader User Card

The first stage of preparing a Mifare® sector read User Card is configuring a
card ID and card KeyA value. These two configuration values are done
simultaneously.

To program a Mifare® Sector Read User Card:

1. Select the Sector Reader tab.

2. In Operation Mode, select the Sector.

3. In Card Type, select either Mifare® 1 K or Mifare® 4 K.
4

From the Transmit Format dropdown menu, select the applicable
transmission format.

5. In /D Location, select values for the Sector Number, Block Number, and
Byte Number fields.

If the Card Serial Number operation mode is being used by the organization,
no programming is available for the user card.

o

Ensure that the Operations is set to Program Card.

7. From the Operation Type dropdown menu, select Program User Card ID
+ KeyA.
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8. Enter the User Card ID number or scroll to a value using the Up and
Down arrows.

The range of possible values is shown just above the User Card /D field.
9. In KeyA:

a. Enter the KeyA to be used by the reader as the unique KeyA for the
organization or site in both the Reader KeyA and the Confirm
Reader KeyA fields.

b. Enter the current KeyA of the card being programmed.

e The KeyA number is hidden by "*" characters, so write down the new
key and keep it in a safe place to avoid exposing this secret key to
unauthorized personnel. The KeyA value is entered as a 12 hexadecimal
digit. The default KeyA is FFFFFFFFFFFF.

e The current KeyA during a new installation is the default KeyA
FFFFFFFFFFFF. For existing sites, the current KeyA is the KeyA entered the
original site installation. The current KeyA remains active until it is
changed after configuring the reader.

10. Place a Mifare® card on the CP-R25 Desktop Programmer antenna area.
11. Click Start to begin programming the Mifare® card.

On completion, a message appears in the Message Log area to verify that
the programming succeeded.

If the programming fails, there is a short buzz and the swipe Card Reader
LEDs lights red for three seconds.

12. To program additional Mifare® User Cards, repeat Step 8 and then Steps
10 and 11.
5.3.2  Programming and Enrolling Fingerprint User Card

Before enrolling a card user’s fingerprint, the card must have a configured card
ID and KeyA value.

There are two options for enrolling fingerprints on a Mifare® User Card. Either
one or two fingerprints can be programmed on the card. This number of
fingerprints is defined by the company security specifications and the card type
used.

To enroll fingerprints on a Mifare® User Card:
1. Select the CP-R25 tab.

2. Select the applicable Operation Mode, either Sector or Card Serial
Number (CSN).

3. In Card Type, select either Mifare® 1 K or Mifare® 4 K.

From the Transmit Format dropdown menu, select the applicable
transmission format.

5. For Sector operation mode, select values for the Sector Number, Block
Number, and Byte Number fields in /D Location.

6. Ensure that the Operations is set to Program Card.
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7.

10.

11.

12.

13.
14.
15.

16.
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From the Operation Type dropdown menu:

a. If Qperation typeis Sector, select Program User Card ID + KeyA +
template.

b. If Operation typeis Card Serial Number (CSN), select Program
User Card KeyA + template.

For Sector Operation Mode, enter the User Card ID number or scroll to a
value using the Up and Down arrows.

The range of possible values is shown just above the User Card ID field.
In KeyA:

a. Enter the KeyA to be used by the reader as the unigue KeyA for the
organization or site in both the Reader KeyA and the Confirm
Reader KeyA fields.

b. Enter the current KeyA of the card being programmed.

e The KeyA number is hidden by "*" characters, so write down the new
key and keep it in a safe place to avoid exposing this secret key to
unauthorized personnel. The KeyA value is entered as a 12 hexadecimal
digit. The default KeyA is FFFFFFFFFFFF.

e The current KeyA during a new installation is the default KeyA
FFFFFFFFFFFF. For existing sites, the current KeyA is the KeyA entered the
original site installation. The current KeyA remains active until it is
changed after configuring the reader.

In Fingers options, select the number of fingers per card to enroll onto the
Mifare® User Card.

[Optional] Select the Verify after enrollment checkbox to verify the
enrolled fingerprints if required. This is usually not required as the CP-R25
Desktop Programmer has an automatic internal verification during
enrollment.

If needed, select the Ignore Template checkbox for a cardholder who is
unable to present a finger for verification.

Note that when this option is selected, the parameters in Finger options in
Step 10 are grayed out.

Place a Mifare® card on the CP-R25 Desktop Programmer antenna area.
Click Start to begin programming the Mifare® card.

Instruct the person whose fingerprints are being enrolled to swipe his/her
finger on the finger sensor, located on the CP-R25 Desktop Programmer,
in the direction indicated by the Fingerprint Directional Indication LEDs.

Follow the instructions messages in the Message Log area to repeat the
fingerprint swipe process three (3) times.

If enabled in the system settings (see Section 7.2), the system alerts if the
card being programmed is not empty. The “The card is not empty. Do you
want to overwrite it?" prompt message is displayed. Choose Continue or
Cancel.
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On a successful completion of all three reads and card programming, 3
short beeps are generated and a success message "Writing template to
card succeeded" appears in the Message Log area.

If the programming fails, there is a short buzz and the swipe Card Reader
LEDs light red for three seconds.

17. To program and enroll additional user cards, repeat Step 8 and then Steps
13 to 16.
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The AS-BO1 software includes additional utilities that allow you to use the
programmer in the best and easiest possible way.

The card utilities are identical for both the Sector Read and CP-R25 tabs. The
CP-R25 tab has additional utilities designed specifically for the fingerprint
swipe application.

6.1 Card Utilities
The card utilities vary depending on the selection of either Sector or Card
Serial Number (CSN) in Operation Mode.

When Card Serial Number (CSN) is selected, there are two card utility
options available.

When Sector is selected, the same two card utilities are available, plus six
additional utilities specific to the Sector type card.

6.1.1 Reading a Configuration Card

This function is used to confirm the card configuration when performing other
functions in order to save time and enhance accuracy.

To read the Configuration cards:
1. Select either the Sector Reader or CP-R25 tab.

2. Select the applicable Operation Mode, either Sector or Card Serial
Number (CSN).

3. In Qperations, select Card utilities.
4. Inthe Qperation Type field, select Read Configuration Card from the
dropdown menu.
Figure 12: Read Configuration Card

Operations
Operation Type

) Program card Fead Confi

[ Fiead Configuration |
Read D from Usger Card
Program 1D into Uszer Card

Change User Card Kewh on selected sector
Change User Card Kewd on all sectors
Erase User Card selected block

Fiead zerial number and card type

Change User Card Kewh and erase data - all sectors

(&) Card utilities

5. Place the Mifare® Configuration Card on the CP-R25 Desktop Programmer
antenna area.

6. Click Start to begin reading the Configuration Card.
The configuration options are displayed on the screen.
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6.1.2  Reading an ID from a User Card

This utility is used to ensure that the Mifare® User Card is configured properly.
This option is only available for the Sector Operation Mode.

To read an ID from a Mifare® User Card:

1. Select either the Sector Reader or CP-R25 tab.

2. In Operation Mode, select Sector.

3. Select the Card Type, either Mifare® 1 K or Mifare® 4 K.

4

From the Transmit Format dropdown menu, select the applicable
transmission format.

In Operations, select Card utilities.

6. From the Operation Type field dropdown menu, select Read ID from
User Card.

Figure 13: Read ID from User Card
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Operation Type
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Change User Card kewh and erase data - all sectors
The KeyA and User Card ID fields appear.
7. Enter the KeyA of the card being read.

8. Place the Mifare® User Card on the CP-R25 Desktop Programmer antenna
area.

9. Click Start to display the card ID in the Mifare® User Card ID field.
6.1.3 Programming a User Card ID

This utility is used to program the User Card ID into a specific location on the
User card without configuring the card template or KeyA.

This option is only available for the Sector Operation Mode.
To program an ID into a Mifare® User Card:

1. Select either the Sector Reader or CP-R25 tab.

2. In Operation Mode, select Sector.

3. Select the Card Type, either Mifare® 1 K or Mifare® 4 K.
4

From the 7ransmit Format dropdown menu, select the applicable
transmission format.

In Operations, select Card utilities.

6. From the Operation Type field dropdown menu, select Program ID into
User Card.
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Figure 14: Program ID into User Card
Operationz
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The KeyA and Mifare® User Card ID fields appear.
7. Enter the KeyA of the card being programmed.

8. Enter the User Card ID or scroll to the value using the Up and Down
arrows. The value can be between 0 and 16777215.

9. Select values for the Sector Number, Block Number, and Byte Number
fields in /D Location.

10. Place the Mifare® User Card on the CP-R25 Desktop Programmer antenna
area.

11. Click Start to begin programming procedure.
6.1.4  Changing the User Card KeyA in a Specific Sector

Use this utility to change the KeyA value in a specific sector of the User Card
without changing the card template or User Card ID.

This option is only available for the Sector Operation Mode.
To change the KeyA in a specific sector:

Select either the Sector Reader or CP-R25 tab.

Select the Sector Operation Mode.

Select the Card Type, either Mifare® 1 K or Mifare® 4 K.
Define the /D Location using the Sector Number field.
In Operations, select Card utilities.

From the Operation Type field dropdown menu, select Change User
Card KeyA on selected sector.

Figure 15: Change User Card KeyA on Selected Sector
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Operations
Operation Type
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® Card ulilfies Read Configuration Card
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Change User Card Kewd on all sectors
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Change Usger Card Kepd and erase data - all sectors

The KeyA fields are displayed.
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7. In KeyA:

a. Enter the KeyA to be used by the reader as the unigue KeyA for the
organization or site in both the Reader KeyA and the Confirm
Reader KeyA fields.

b. Enter the current KeyA of the card being programmed.

e The KeyA number is hidden by "*" characters, so write down the new
key and keep it in a safe place to avoid exposing this secret key to
unauthorized personnel. The KeyA value is entered as a 12 hexadecimal
digit. The default KeyA is FFFFFFFFFFFF.

e The current KeyA during a new installation is the default KeyA
FFFFFFFFFFFF. For existing sites, the current KeyA is the KeyA entered the
original site installation. The current KeyA remains active until it is
changed after configuring the reader.

8. Place the Mifare® User Card on the CP-R25 Desktop Programmer antenna
area.

9. Click Start to program the card with the new KeyA.
6.1.5 Changing the User Card KeyA in All Sectors

Use this utility to change the KeyA value in all sectors of the User Card without
changing the card template or User Card ID.

This option is only available for the Sector Operation Mode.
7o change the KeyA in a specific sector:

1. Select either the Sector Reader or CP-R25 tab.

Select the Sector Operation Mode.

Select the Card Type, either Mifare® 1 K or Mifare® 4 K.
In Operations, select Card utilities.

v WN

From the Operation Type field dropdown menu, select Change User
Card KeyA on all sectors.

Figure 16: Change User Card KeyA on All Sectors
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The KeyA fields are displayed.
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6. In KeyA:

a. Enter the KeyA to be used by the reader as the unigue KeyA for the
organization or site in both the Reader KeyA and the Confirm
Reader KeyA fields.

b. Enter the current KeyA of the card being programmed.

e The KeyA number is hidden by "*" characters, so write down the new
key and keep it in a safe place to avoid exposing this secret key to
unauthorized personnel. The KeyA value is entered as a 12 hexadecimal
digit. The default KeyA is FFFFFFFFFFFF.

e The current KeyA during a new installation is the default KeyA
FFFFFFFFFFFF. For existing sites, the current KeyA is the KeyA entered the
original site installation. The current KeyA remains active until it is
changed after configuring the reader.

7. Place the Mifare® User Card on the CP-R25 Desktop Programmer antenna
area.

8. Click Start to program the card with the new KeyA.
6.1.6  Erasing Specific User Card Data

This utility is used to erase specific information from a defined sector within
the card.

This option is only available for the Sector Operation Mode.
To erase specific user card data:

1. Select either the Sector Reader or CP-R25 tab.

Select the Sector Operation Mode.

Select the Card Type, either Mifare® 1 K or Mifare® 4 K.
In the Operations area, select Card utilities.

From the Operation Type field dropdown menu select Erase User Card
selected block.

Figure 17: Erase User Card Selected Block
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The KeyA field is displayed.
6. Enter the KeyA for the card being read.

7. Place the Mifare® User Card on the CP-R25 Desktop Programmer antenna
area.

8. Click Start to erase the data from the specific sector within the card.
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6.1.7  Read Serial Number and Card Type

Each Mifare® card has a Unique Serial Number (UID). Use this utility to see a
card’s UID and card type.

To read a Mifare® User Card Serial Number and Type:
1. Select either the Sector Reader tab or the CP-R25 tab.

2. From the Transmit Format dropdown menu, select the applicable
transmission format.

3. Inthe Qperations area, select Card utilities.

4. From the Operation Type field dropdown menu, select Read serial
number and card type.

Figure 18: Read Serial Number and Card Type
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The Serial Number field appears.

5. Place the Mifare® User Card on the CP-R25 Desktop Programmer antenna
area.

6. Click Start to display the serial number and card type.
6.1.8  Changing KeyA and Erasing All Data

Use this utility to format a card to define a new KeyA, which is written on all
sectors.

This option is only available for the Sector Operation Mode.
To format the User Card:

1. Select either the Sector Reader or CP-R25 tab.

Select the Sector Operation Mode.

Select the Card Type, either Mifare® 1 K or Mifare® 4 K.
In the Operations area, select Card utilities.

A N

From the Operation Type field dropdown menu, select Change User
Card KeyA and erase data - all sectors.
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Figure 19: Change User Card KeyA and Erase Data — All Sectors
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The KeyA fields are displayed.
6. In KeyA:

a. Enter the KeyA to be used by the reader as the unique KeyA for the
organization or site in both the Reader KeyA and the Confirm
Reader KeyA fields.

b. Enter the current KeyA of the card being programmed.

e The KeyA number is hidden by "*" characters, so write down the new
key and keep it in a safe place to avoid exposing this secret key to
unauthorized personnel. The KeyA value is entered as a 12 hexadecimal
digit. The default KeyA is FFFFFFFFFFFF.

e The current KeyA during a new installation is the default KeyA
FFFFFFFFFFFF. For existing sites, the current KeyA is the KeyA entered the
original site installation. The current KeyA remains active until it is
changed after configuring the reader.

Note

7. Place the Mifare® User Card on the CP-R25 Desktop Programmer antenna
area.

8. Click Start to start the formatting procedure.

This operation may take up to 30 seconds for a 1K card and several minutes
for a 4K card. Do not close the application or remove the card until you

> . . .
receive a confirmation message.

Note
6.2 Fingerprint Utilities

The fingerprint utility allows you to enroll fingerprints to a pre-configured User
card without changing the various information written on the card or to verify
the fingerprint written on to a card.

6.2.1 Enrolling Fingerprints on a Pre-configured User Card

The AS-BO1 software allows you to enroll fingerprints onto a card already
configured with the User card ID.

7o enroll fingerprints to a pre-configured user card:
1. Select the CP-R25 tab.
2. Inthe Operations area, select Finger utilities.
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3. From the Operation Type dropdown menu, select Enroll fingerprints to

card.
Figure 20: Enroll Fingerprints to Card
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Operation Type
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Select the number of fingers per card to enroll.

5. [Optional] In Finger options, select the Verify after enrollment checkbox
to verify the enrolled fingerprints if required. This usually not required as
the CP-R25 Desktop Programmer has an automatic internal verification on
enrollment.

For security reasons, enter the KeyA value.

Define the /D Location using the Start Sector field.

Place the card on the CP-R25 Desktop Programmer antenna area.
Click Start to begin programming the Mifare® card.

0. Instruct the person whose fingerprints are being enrolled to swipe his/her
finger on the finger sensor, located on the CP-R25 Desktop Programmer,
in the direction indicated by the Fingerprint Directional Indication LEDs.

11. Follow the instructions messages in the Message Log area to repeat the
fingerprint swipe process three (3) times.

= © ® N o

To write the finger template onto a specific card sector, define the sector
number by typing or selecting the number in the Sector Number field

Note located in the finger options section of the screen.

6.2.2  Verifying Fingerprint Enrolliment on a User Card

Verifying fingerprint enrollment on a Mifare® User Card can be done as a
separate function or at the same time an enrollment is preformed.

As an added security measure the CP-R25 Desktop Programmer automatically
does an internal verification to ensure accuracy. That is why during the
enrollment process, more than one swipe is required.

To verify fingerprint enrollment on a Mifare® User Card:

1. Select the CP-R25 tab.

2. Inthe Operations area, select Finger utilities.

3. From the Operation Type dropdown menu, select Verify live fingerprint.

CP-R25 Hardware and AS-BO1 Software Manual 37



Additional Programmer Utilities
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10.
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Figure 21: Verify Live Fingerprints
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Select the number of fingers that were enrolled for verification.

For security reasons, enter the KeyA value.

Select the sector number that starts the fingerprint template location.
Place the card on the CP-R25 Desktop Programmer antenna area.
Click Start to begin programming the Mifare® card.

Instruct the person whose fingerprints are being verified to swipe his/her
finger on the finger sensor, located on the CP-R25 Desktop Programmer,
in the direction indicated by the Fingerprint Directional Indication LEDs.

Follow the instructions messages in the Message Log area to repeat the
fingerprint swipe process once for each template.
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7. Global Options

This section provides instruction on how to define the software behavior and
change the password used to enter the application.

71 Change Password

For security reasons, it is highly advisable to change the login password to the
AS-B01 software from the default password.
To change the AS-B0O1 application entry password.
1. In the File menu, click Options > Change Password.
The Change Password window opens.
Figure 22: AS-B01 Change Password

Change Password ®

Current Pagzword

Mew Pasgward:

Confirn Pazzword:

[ Ok l l Cancel ]

2. Complete the fields as required.
Passwords are case sensitive.

For higher security, make sure that the password you choose is more than
4 |etters long. Mixing letters and numbers also substantially strengthens
the password.

All passwords are hidden by '*' characters to avoid exposing it to an
unauthorized user.

3. Click OK.
The password is changed.

7.2 Card Overwrite

Enabling the Card Overwrite option causes the system to issue a warning when
attempting to write information onto a card with data already stored on it.

If disabled, the system overwrites information automatically without warning
the user.
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7o enable the Card Overwrite warning:
1. In the File menu click Options > Card Overwrite.
The Overwrite window opens.
Figure 23: Enable Card Overwrite Popup Window

Enable pop-up message Card already programmed - do you want to
ovenmite? during enrolling a fingerprint.
Fay &itention |

“w'hen pop-up message are disabled, finger template and [0 data might
be deleted withaut warning.

[ Ok ] [ Cancel

2. Verify that the checkbox is selected.
3. Click OK.

7.3 Updating Firmware

You may need to periodically update your firmware.
7o update the CP-R25 Desktop Programmer firmware:
1. In the File menu click Options > Firmware Programming.
The Desktop Reader Firmware Programming window opens.
Figure 24: AS-B01 Desktop Reader Firmware Programming

Desktop Reader Firmware Programming @

Dizconnect Programmer’s USE cable.
bir file location

[y ProjectsifingerprintsCPR-255EWAR KD ebughE e \CPR-25v1_5_0_0_25-0CT-11.bin

Browsze

[ 0K H Cancel ]

2. [Optional] You can change the default firmware location that is displayed
in the .bin file location field:

a. Click Browse.
The standard Windows Explorer window opens.

b. Navigate to the folder containing the binary firmware file to
download.
c.  Select the binary firmware file.

3. Make sure the USB cable is disconnected from the CP-R25 Desktop
Programmer. If the cable is still connected, a window opens telling you to
disconnect the cable.
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Figure 25: Disconnect USB Cable

Disconnect Programmet’s USE cable.

The indicator at the left bottom side of the screen displays Disconnected.
4. Click OK.
You return to the Desktop Reader Firmware Programming window.
5. Click OK.
The Connect Cable window opens.
Figure 26: Connect USB Cable

Connect Programmer’s USB cable.

Cancel

6. Connect the USB Cable.

7. Wait until the indicator at the left bottom side of the screen displays
Connected.

The installation automatically begins. On completion, a confirmation
screen opens.

8. Click OK.
The Desktop firmware is now updated.

Two more messages should immediately follow in the Message window:
"Mifare® Programming Reader Disconnected" and "Mifare® Programming
Reader Connected".

The Desktop Programmer is now ready for use.
y  Be careful not to select a wrong firmware file, as it may cause permanent

Desktop reader hardware failure.

Note
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Maintenance

To maximize the lifetime of the product, we recommend following these
guidelines as closely as possible.

Do not expose the unit to water or rain or to humidity over the specified
safety level.

Do not expose the unit to direct sunlight for extended periods. This can
cause overheating and system failure.

Avoid dropping the unit onto the ground. This may cause
electromechanical failure.
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Field Descriptions secURTY PRODLETS

The following table describes the various fields that appear in the AS-BO1
software application when configuring the CP-R25 Desktop Programmer,
Mifare® cards and/or tags:

Table 2: Field Descriptions

Field Name Description

Card Serial Number (CSN) In the Operation Mode area this option is selected if the
reader has to transmit only the card serial number. Each
Mifare® card has a Unique Serial Number (UID) to uniquely
identify the card.

Card Type e The Mifare® card type determines the size and
memory location on the card. There are two options:

o Mifare® 1K memory — The 1024 x 8 bit EEPROM
memory is organized in 16 sectors with 4 blocks of 16
bytes each. In the erased state the EEPROM cells are
read as a logical “0”, in the written state as a logical
.

o Mifare® 4K memory — The 4096 x 8 bit EEPROM
memory is organized in 32 sectors with 4 blocks and 8
sectors with 16 blocks. Each block contains 16 bytes.
In the erased state the EEPROM cells are read as a
logical “0”, in the written state as a logical “1".

Confirm Password Used to confirm a new password entered in the New
Password field.

Current Password Password used to enter the AS-BO1 software application,
and when changing the password.

Enable Buzzer Activates or deactivates the reader’s buzzer control.

Enable LED Activates or deactivates the reader’s LED control.

Failed operation Enables the reader to transmit to the panel any failed

operations. These are then displayed in the Message Log
Area of the GUI.

ID Location All sectors in the Mifare® card contain 3 blocks of 16 bytes
for storing data. This parameter defines where the data is
stored in these data blocks. The location is defined by the
company security specifications.

KeyA Password Unique key used as a security access code. This code used
is specified by the company security policies. The key is
entered as a 12 digit hexadecimal value with digit values
of 0-9, A-F.

Keypad Defines the keypad type used to enter codes on an access
reader.
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Field Descriptions

Field Name
Lockout Attempts

Lockout Duration

New Password

Reader KeyA

Sector

Transmit Format

Mifare® User Card ID

44

Description

Defines the number times a user can present a wrong card
or swipe an unverified fingerprint before the reader locks
the door for a predefined period of time.

Defines how long a card is locked out of the system after
too many invalid attempts at swiping the card through the
reader or fingerprint scanned due to some inconsistencies
with the configured card being used.

Field used to enter a new password. Passwords are case
sensitive. For higher security, make sure that the
passwords you choose are more than 4 letters. Mixing
letters and numbers also substantially strengthens the
password.

The Mifare® card storage is divided into sectors with each
sector being protected by two different keys, KeyA and
KeyB. These keys are programmable according to company
security specifications. KeyB is not supported.

In the Operation Mode area this option is selected if the
reader has to transmit encrypted data from the card
secured memory. More screen options are added when
selecting Sector mode including the Reader KeyA and the
/D Location fields.

Wiegand protocol is a secure transmission format where
access control is required. The different bit configuration is
used to define different security options specified by the
company security officer.

Unique ID assigned to the card. This ID number is obtained
from the company security officer. The ID number is a
numeric with a range of 0 — 16777215.
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Additional Mifare® Card Memory Map Information  scciaivrronicrs

C.1 Manufacture Block

This is the first data block (block 0) of the first sector (sector 0). It contains the
IC manufacturer data. Because of security and system requirements, this block
is write-protected after having been programmed by the IC manufacturer at
production.

When the Rosslare Mifare® reader operation mode is configured to " card serial
number*, the Unique ID of the card is read from manufacture block.
C.2 Data Blocks
All sectors contain 3 blocks of 16 bytes for storing data (Sector O contains only
two data blocks and the read-only manufacturer block).
The data blocks can be configured by the access bits as:

Read/write blocks (for example, contactless access control)

Value blocks (for example, electronic purse applications — not supported
by AS-BO1).
An authentication command must be carried out before any memory
operation to allow further commands. Authentication commands are based on
KeyA, KeyB, and on Access Condition bits. AS-BO1 supports programming only
KeyA, thus both Access Bits and KeyB modifications are not supported; their
location in the following diagram is indicated in black.
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Additional Mifare® Card Memory Map Information

Figure 27: Mifare® 1K Memory Diagram
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For further details about Mifare® cards, refer to the NXP Semiconductor
Mifare® datasheet.
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Sample Worksheets

SECURITY PRODUCTS

When entering information, the information must be obtained from the
company security officer. To assist in preparing the information to be entered,

the following sample form can be used.

Employee Security Card Configuration

Field

Employee Name

Employee ID #

Employee Company ID
Employee Dept.

Card Serial Number (if applicable)
Reader KeyA

Transmit Format

Card Type (1K or 4K)

ID Location — Sector Number
ID Location — Block Number

ID Location — Byte Number
Mifare® User Card ID

Number of Fingerprints (1 or 2)
LED Control

Buzzer Control

Lockout Attempts

Lockout Duration

Batch Order Code

Configuration
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Limited Warranty

ROSSLARE'S TWO-YEAR LIMITED WARRANTY is applicable worldwide. This
warranty supersedes any other warranty. ROSSLARE'S TWO-YEAR LIMITED
WARRANTY is subject to the following conditions:

WARRANTY

Warranty of ROSSLARE'S products extends to the original purchaser
(Customer) of the ROSSLARE product and is not transferable.

ProbuCTS COVERED BY THIS WARRANTY AND DURATION

ROSSLARE warrants that the CP-R25 Mifare® Card & Tag Programmer and
Fingerprint Enroller to be free from defects in materials and assembly in the
course of normal use and service. The warranty period commences with the
date of shipment to the original purchaser and extends for a period of 2 years
(24 months).

WARRANTY REMEDY COVERAGE

In the event of a breach of warranty, ROSSLARE will credit Customer with the
price of the Product paid by Customer, provided that the warranty claim is
delivered to ROSSLARE by the Customer during the warranty period in
accordance with the terms of this warranty. Unless otherwise requested by a
ROSSLARE representative, return of the failed product(s) is not immediately
required.

If ROSSLARE has not contacted the Customer within a sixty (60) day holding
period following the delivery of the warranty claim, Customer will not be
required to return the failed product(s). All returned Product(s), as may be
requested at ROSSLARE'S sole discretion, shall become the property of
ROSSLARE.

To exercise the warranty, the user must contact ROSSLARE Enterprises Ltd. to
obtain an RMA number after which, the product must be returned to the
Manufacturer freight prepaid and insured.

In the event ROSSLARE chooses to perform a product evaluation within the
sixty (60) day holding period and no defect is found, a minimum US$ 50.00 or
equivalent charge will be applied to each Product for labor required in the
evaluation.

ROSSLARE will repair or replace, at its discretion, any product that under
normal conditions of use and service proves to be defective in material or
workmanship. No charge will be applied for labor or parts with respect to
defects covered by this warranty, provided that the work is done by ROSSLARE
or a ROSSLARE authorized service center.
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Limited Warranty secuRTY PRODLETS

EXCLUSIONS AND LIMITATIONS

ROSSLARE shall not be responsible or liable for any damage or loss resulting
from the operation or performance of any Product or any systems in which a
Product is incorporated. This warranty shall not extend to any ancillary
equipment not furnished by ROSSLARE, which is attached to or used in
conjunction with a Product, nor to any Product that is used with any ancillary
equipment, which is not furnished by ROSSLARE.

This warranty does not cover expenses incurred in the transportation, freight
cost to the repair center, removal or reinstallation of the product, whether or
not proven defective.

Specifically excluded from this warranty are any failures resulting from
Customer's improper testing, operation, installation, or damage resulting from
use of the Product in other than its normal and customary manner, or any
maintenance, modification, alteration, or adjustment or any type of abuse,
neglect, accident, misuse, improper operation, normal wear, defects or
damage due to lightning or other electrical discharge. This warranty does not
cover repair or replacement where normal use has exhausted the life of a part
or instrument, or any modification or abuse of, or tampering with, the Product
if Product disassembled or repaired in such a manner as to adversely affect
performance or prevent adequate inspection and testing to verify any warranty
claim.

ROSSLARE does not warrant the installation, maintenance, or service of the
Product. Service life of the product is dependent upon the care it receives and
the conditions under which it has to operate.

In no event shall ROSSLARE be liable for incidental or consequential damages.
LimiTED WARRANTY TERMS
THIS WARRANTY SETS FORTH THE FULL EXTENT OF ROSSLARE'S WARRANTY.

THE TERMS OF THIS WARRANTY MAY NOT BE VARIED BY ANY PERSON, WHETHER OR NOT
PURPORTING TO REPRESENT OR ACT ON BEHALF OF ROSSLARE.

THIS LIMITED WARRANTY IS PROVIDED IN LIEU OF ALL OTHER WARRANTIES. ALL OTHER
WARRANTIES EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE SPECIFICALLY EXCLUDED.

IN NO EVENT SHALL ROSSLARE BE LIABLE FOR DAMAGES IN EXCESS OF THE PURCHASE PRICE OF
THE PRODUCT, OR FOR ANY OTHER INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES,
INCLUDING BUT NOT LIMITED TO LOSS OF USE, LOSS OF TIME, COMMERCIAL LOSS,
INCONVENIENCE, AND LOSS OF PROFITS, ARISING OUT OF THE INSTALLATION, USE, OR INABILITY
TO USE SUCH PRODUCT, TO THE FULLEST EXTENT THAT ANY SUCH LOSS OR DAMAGE MAY BE
DISCLAIMED BY LAW.

THIS WARRANTY SHALL BECOME NULL AND VOID IN THE EVENT OF A VIOLATION OF THE
PROVISIONS OF THIS LIMITED WARRANTY.
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Asia Pacific, Middle East,
Africa

Rosslare Enterprises Ltd.

Kowloon Bay, Hong Kong

Tel: +852 2795-5630

Fax: +852 2795-1508
support.apac@rosslaresecurity.com

United States and Canada
Rosslare Security Products, Inc.
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